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Preface
Oracle® Endeca Information Discovery Integrator is a powerful visual data integration environment that
includes:

The Integrator Acquisition System (IAS) for gathering content from delimited files, file systems, JDBC
databases, and Web sites.

Integrator ETL, an out-of-the-box ETL purpose-built for incorporating data from a wide array of sources,
including Oracle BI Server.

In addition, Oracle Endeca Web Acquisition Toolkit is a Web-based graphical ETL tool, sold as an add-on
module. Text Enrichment and Text Enrichment with Sentiment Analysis are also sold as add-on modules.
Connectivity to data is also available through Oracle Data Integrator (ODI).

About this guide
This guide describes how to download, install, and start the Integrator Acquisition System on Windows and
Linux.

Who should use this guide
This guide is intended for developers who are responsible for loading source data into an Endeca data
domain.

Conventions used in this guide
The following conventions are used in this document.

Typographic conventions

The following table describes the typographic conventions used in this document.

Typographic conventions

Typeface Meaning

User Interface Elements This formatting is used for graphical user interface elements such as
pages, dialog boxes, buttons, and fields.

Code Sample This formatting is used for sample code phrases within a paragraph.

<Variable Name> This formatting is used for variable values, such as <install path>.

File Path This formatting is used for file names and paths.
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Symbol conventions

The following table describes symbol conventions used in this document.

Symbol conventions

Symbol Description Example Meaning

> The right angle bracket, File > New > Project From the File menu,
or greater-than sign, choose New, then from
indicates menu item the New submenu,
selections in a graphic choose Project.
user interface.

Contacting Oracle Customer Support
Oracle Customer Support provides registered users with important information regarding Oracle software,
implementation questions, product and solution help, as well as overall news and updates from Oracle.

You can contact Oracle Customer Support through Oracle's Support portal, My Oracle Support at
https://support.oracle.com.
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Chapter 1

Before You Install

This section provides an overview of the Integrator Acquisition System, system requirements, and other
information you need to know before installing.

Overview of the Integrator Acquisition System

Choosing to install IAS into WebLogic Server or Jetty Web server

System requirements

IAS Document Conversion Module

Supported data sources

Recommended reading

Overview of the Integrator Acquisition System
The Integrator Acquisition System, or IAS, is a set of components that crawl source data stored in a variety of
formats including: file systems, JDBC databases, flat files, Web servers, and custom data sources. IAS
transforms the data, if necessary, and outputs the data to an XML file or a Record Store that can be accessed
by Integrator ETL.

Choosing to install IAS into WebLogic Server or Jetty Web
server
IAS installs into an application server and runs as a hosted application. IAS supports both WebLogic Server
and Jetty Web server.

You typically install IAS into WebLogic Server in scenarios where your other Endeca products are also running
in WebLogic Server and in production environments. For example, you might have IAS, Integrator ETL,
Studio, and Endeca Server running as applications in WebLogic Server. Note however, IAS does not require
many features provided by WebLogic, so this installation approach is primarily for ease of administration when
hosting the entire Endeca stack.

You typically install IAS into Jetty in scenarios where you want a light-weight Web server to host IAS while you
perform data development work in a development environment.

System requirements
The Integrator Acquisition System has the following system requirements. In this guide, the term “x64” refers
to any processor compatible with the AMD64/EM64T architecture. Hard disk capacity must be sufficient to
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store the records written to the Record Store or to record output files. Please contact your Oracle
representative if you need more information on hardware sizing.

Supported operating systems

IAS is supported on the following 64-bit operating systems:

Operating System Description

Oracle Linux Oracle Linux Release 6 for x64

Both the Oracle Unbreakable Enterprise Kernel and the Red Hat Compatible Kernel
are supported.

Linux RHEL
• Red Hat Enterprise Linux Server version 6 for x64

• Red Hat Enterprise Linux Advanced Platform version 6 for x64

For best performance on Red Hat Linux (Server and Advanced), Oracle recommends
the latest version of RHEL.

Windows Windows Server 2012 R2

Hardware requirements for Linux and Windows on x64

Minimum hardware requirements:

• x64 processor, minimum 1.8 GHz

• 4 GB of RAM

• 500 MB of available hard drive space

Software requirements when installing IAS into Jetty Web server

There are no additional software requirements if you install IAS into the Jetty Web server. IAS installs a
version of the JDK and installs Jetty.

WebLogic version requirements when installing IAS into WebLogic Server

The supported software version of Oracle WebLogic Server is 12.1.3, which is part of the WebLogic Server
12c product. The only supported installer version is the Generic version, which is available in the Oracle
WebLogic Server 12c (12.1.3) Generic and Coherence package. The download instructions for this package
are in Downloading WebLogic Server on page 11.

The Generic version is used because it is a platform-agnostic installer (i.e., can be used on both Linux and
Windows platforms) and also because it allows you to use a 64-bit JVM. The 64-bit JVM is required.

JDK requirements when installing IAS into WebLogic Server

During the WebLogic installation procedure (and later during the WebLogic domain creation procedure), you
are prompted for a JDK (Java Development Kit). This provides the JRE (Java run-time environment) needed
by the installation program to run.
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Note: While some WebLogic Server installers include a bundled JDK, the Generic installation program
(wls_generic.jar) doesn't. Therefore, you must already have the JDK available that you can
specify during the installation procedure.

IAS supports the following versions of the JDK:

• Java SE JDK 7u67+ x64

• Java SE JDK 8u66+ x64

You can download either of these from the Oracle Technology Network. Be sure to download the appropriate
version for your operating system.

When installing the JDK, be sure that the path to the install location doesn't contain any spaces. For example,
the default destination path on Windows is:

C:\Program Files\Java\jdk1.X.X_XX

Acquisition System Installation Guide

Because the space in "Program Files" causes problems with the installer, you must change the destination
path to a directory similar to this example:

C:\Java\jdk1.X.X_XX

The JDK screen for the destination folder path should look like this:
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IAS Document Conversion Module
The IAS Document Conversion Module is installed and enabled by default as part of the IAS installation. (IAS
repackages and calls Outside In® Search Export 8.5.2 to perform document conversion during a crawl.)

For a list of supported file formats that IAS can crawl and process, see "Appendix B File Formats Supported
by the IAS Document Conversion Module" in the Integrator Acquisition System Developer's Guide.

Supported data sources
For the full list of all supported data sources and information about configuring each data source, see the
Integrator Acquisition System Developer's Guide.

Recommended reading
Before installing, Oracle recommends that you read the following documents for important information about
the release.

Getting Started Guide

The Oracle Endeca Information Discovery Getting Started Guide guides you through the process of exploring
a sample Endeca Information Discovery application.

Integrator User's Guide

The Oracle Endeca Information Discovery Integrator ETL User's Guide describes how to use the Oracle
Endeca Information Discovery Integrator ETL to add data into an Endeca data domain.

Release Notes

Refer to the release notes for information about new features, changed features, and bug fixes for this
release. The release notes (README.txt) are part of the IAS documentation download. After installation,
release notes are also available in the following location:

• Windows: <install path>\Oracle\Endeca\IAS\<version>

• UNIX: <install path>/Oracle/Endeca/IAS/<version>
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Installing the Integrator Acquisition System

This section describes how to install IAS into either Jetty or into WebLogic Server and then describes the
contents of the installation directory.

Downloading IAS

About installing IAS on WebLogic Server

Installing on Windows

Installing on UNIX

Web Crawler installation

Package contents and directory structure

Downloading IAS
You download IAS from the Oracle Software Delivery Cloud.

To download IAS:

1. Go to the Oracle Software Delivery Cloud and sign in.

2. Accept the Export Restrictions.

3. Check Programs if it isn't already.

4. In the Product text box, enter Oracle Endeca Information Discovery Integrator.

5. Click Select Platform, check the appropriate platform for your environment, and click Select.

Oracle Endeca Information Discovery Integrator displays in the Selected Products table.

6. Click Continue.

7. Verify that Available Release and Oracle Endeca Information Discovery Integrator 3.2.0... are
both checked, then click Continue.

Remember that IAS 3.2.0 is a component of OEID 3.2.0.

8. Accept the Oracle Standard Terms and Restrictions and click Continue.

9. In the File Download popup, click the ZIP file for Oracle Endeca Information Discovery Integrator
Acquisition System.

Make a note of the part number: you need this information to identify it later.

10. Click Save to download the file and if necessary, click Open Folder in your browser to locate the ZIP
file.
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About installing IAS on WebLogic Server
You can skip this section if you plan to install IAS into Jetty. You can install IAS as an application running in
Oracle WebLogic Server. In most installation scenarios, you install IAS on the same WebLogic Server
instance as Integrator ETL Server.

Before installing IAS into WebLogic Server, you must perform the following installation tasks:

1. Download and install the JDK.

2. Download and install WebLogic Server.

You install IAS into WebLogic Server by running the IAS installation script and selecting WebLogic Server as
the installation target. The IAS installation script creates and configures a WebLogic domain for IAS. By
default, the new IAS domain is created in production mode rather than development mode.

For full instructions on installing all of Oracle Endeca Information Discovery (Endeca Server, Integrator ETL,
Studio, and Provisioning Service) on a single WebLogic Server in a Windows environment, see the Oracle
Endeca Information Discovery Getting Started Guide.

Downloading WebLogic Server

Installing WebLogic Server

Downloading WebLogic Server

WebLogic Server is downloaded from the Oracle Software Delivery Cloud.

To download the WebLogic Server software:

1. Go to the Oracle Software Delivery Cloud and sign in.

2. Accept the Export Restrictions.

3. Check Programs if it isn't selected already.

4. In the Product text box, type Oracle Endeca Server.

5. Click Select Platform, check the appropriate platform for your environment, and click Select.

Oracle Endeca Server displays in the Selected Products table.

6. Click Continue.

7. Verify that Available Release and Oracle Endeca Server 7.7.0... are both checked, then click
Continue.

8. Review and accept the Oracle Standard Terms and Restrictions and click Continue.

The list of available media packs displays.

9. In the File Download popup, either click the zip file for the following module:

• Oracle Weblogic Server 12cR1 (12.1.3) Generic and Coherence

The selected modules are downloaded to your machine. Make a note of the part number: you need this
information to identify it later.
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Installing WebLogic Server

This topic provides a brief description of how to install Oracle WebLogic Server, which is the Web server
container in which IAS is hosted.

This topic describes the installation of Oracle WebLogic Server 12.1.3, which is part of the WebLogic Server
12c product. This procedure applies to the Generic version of the installer (the installer file is named
fmw_12.1.3.0.0_wls.jar).

Before starting this procedure, make sure that you have downloaded these two components:

1. The Generic version of the WebLogic installer, which you downloaded in Downloading WebLogic Server
on page 11.

2. The Oracle Java SE 7 or 8 JDK, as described in System requirements on page 6.

The installation instructions in this topic are a distillation of the complete instructions in the Oracle Installation
Guide for Oracle WebLogic Server, which is available online at:
https://docs.oracle.com/middleware/1213/core/WLSIG/toc.htm

These distilled instructions concentrate on installing only those WebLogic Server components that are
mandatory for IAS.

To install WebLogic Server:

1. Make sure that you have installed the Java SE 7 or 8 JDK on the machine you're installing WebLogic
Server on.

2. Unpack the ZIP file of the Generic version of the WebLogic installer.

The ZIP extracts the fmw_12.1.3.0.0_wls.jar file.

3. From a command prompt, navigate to the directory where the fmw_12.1.3.0.0_wls.jar installer
file is stored.

When installing WebLogic Server on Linux, do not run the installation program as the root user.

4. Launch the installer in Graphical Mode by running:

java -jar fmw_12.1.3.0.0_wls.jar

Acquisition System Installation Guide

When the installer runs, it displays the installation wizard's Welcome screen.

Oracle® Endeca Information Discovery Integrator: Integrator Version 3.2.0 • January 2016

https://docs.oracle.com/middleware/1213/core/WLSIG/toc.htm


Installing the Integrator Acquisition System 13

5. At the Welcome screen, click Next.
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6. At the Installation Location screen, enter the name of the Middleware home directory in the Oracle
Home field.

This will be the $MW_HOME directory of your installation. You can either accept the default location or
enter a new one. The directory name may only contain alphanumeric, hyphen (-) , dot (.), and
underscore (_) characters, and must begin with an alphanumeric character.

If the specified directory exists, it must be empty. If it doesn't exist, the installer creates it.

Click Next when you're done.
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7. At the Installation Type screen, leave WebLogic Server selected and click Next.
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8. At the Prerequisite Checks screen, wait for the installer to verify your operating system and Java
version, then click Next.
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9. At the Security Updates screen, if you want to receive security updates, enter your support details
and click Next.

If you don't want to receive updates, uncheck I wish to receive security updates via My Oracle
Support, click Next, then click Yes in the pop-up.

Oracle® Endeca Information Discovery Integrator: Integrator Version 3.2.0 • January 2016
Acquisition System Installation Guide



Installing the Integrator Acquisition System 18

10. At the Installation Summary screen, verify that you're installing the correct products, then click
Install.
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11. At the Installation Progress screen, wait for the installation to complete, then click Next.
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12. At the Installation Complete screen, uncheck Automatically Launch the Configuration Wizard,
then click Finish to exit the installer.

You'll configure WebLogic Server later in the installation process.

On Windows, an Oracle WebLogic shortcut is created in the Start Menu. One of the sub-entries in this
shortcut is to the WebLogic Server documentation.

The next step is to install IAS.

Installing on Windows
This section describes how to install the Integrator Acquisition System on Windows.

Creating a user for the Endeca services on Windows

Installing IAS on Windows

Installing IAS silently on Windows
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Creating a user for the Endeca services on Windows

This topic applies only to IAS installations on Jetty Web server. You can skip this topic if you install IAS on
WebLogic Server. You must run the Endeca services as a specified user, for which you can control
permissions.

The IAS installation script prompts for the Endeca services user during the installation process. Oracle
recommends that you create a user account called endeca that has the file and directory permissions to
access all necessary files for your application. However, you can use any user that you prefer, as long as it
meets these requirements.

To create the user endeca:

1. Ensure that you have administrator privileges on the local machine.

2. From the Windows Control Panel, select Computer Management>Administrative Tools.

3. In the tree pane of the Computer Management window, select System Tools>Local Users and
Groups.

4. Right-click Users and select New User.

5. In the New User dialog box, do the following:

(a) Enter endeca for both the User name and the Full name.

(b) Optionally, enter a description.

(c) Set a password for user endeca.

Note: The user must have a non-blank password, because the installer will not accept a
blank password for the services user.

(d) Uncheck User must change password at next logon.

6. Click Create to create the new user, and then Close to exit the dialog box.

7. Close the Computer Management window, but do not exit Administrative Tools.

8. From Administrative Tools, do the following:

(a) Open Local Security Policy.

(b) In the Local Security Settings window, select Local Policies>User Rights Assignments.

(c) From the list of policies on the right, open Log on as a Service.

(d) Add user endeca to the list of users that can register a process as a service.

(e) Close the dialog box and exit Administrative Tools.

Installing IAS on Windows

The installation process is made up of two steps: extracting a ZIP to put the IAS files on disk and then running
an IAS installation script to deploy IAS. The script prompts you to select a server type to host IAS. If you
select Jetty Web server, the script then gathers environment and user information and then creates and starts

Oracle® Endeca Information Discovery Integrator: Integrator Version 3.2.0 • January 2016
Acquisition System Installation Guide



Installing the Integrator Acquisition System 22

the Endeca IAS Service. If you select WebLogic Server, the script creates, deploys, and starts an IAS
application running in WebLogic Server.

Before installing, ensure that you have met the following pre-requisites:

• If you are installing on Jetty, ensure you have administrator privileges on the local machine.

To install IAS on Windows:

1. In your local environment, locate the Endeca IAS software that you downloaded from the Oracle
Software Delivery Cloud.

2. Extract the ZIP file to C:\.

This creates the IAS files on disk at C:\Oracle\Endeca\IAS.

3. Open a command prompt window and change to C:\Oracle\Endeca\IAS\<version>\bin.

4. Run the ias-setup.bat script.

5. Select a server type to host the IAS installation:
• Type 1 to install IAS into WebLogic Server and press Enter.

• Type 2 to install IAS into Jetty Web server and press Enter.

6. If you selected 1 for WebLogic Server:

(a) Specify the WebLogic home location or accept the default home location of
C:\Oracle\Middleware\wlserver by pressing Enter.

(b) Specify a WebLogic domain name for IAS. Oracle recommends specifying ias.

(c) Specify a username for the domain.

(d) Specify a password for the domain and confirm the password.

(e) Specify a port for the WebLogic domain or accept the default of 8401 by pressing Enter.

(f) Specify the fully qualified hostname that runs IAS or accept the default by pressing Enter.

The IAS installation script creates the WebLogic domain with the username and password you
specified, deploys IAS as an application into the domain, and then restarts the domain.

7. If you selected 2 for Jetty:

(a) Specify a domain and username to run the Endeca IAS Service and press Enter.

This is typically the endeca that you created previously, but can be any user that has the file and
directory permissions to access all necessary files for your application.

(b) Specify the password for the user.

(c) Confirm the password for the user.

(d) Specify a port for the Endeca IAS Service, or accept the default of 8401 by pressing Enter

(e) Specify a shutdown port for the Endeca IAS Service, or accept the default of 8403 by pressing
Enter.

(f) Specify the fully qualified hostname that runs IAS, or accept the default by pressing Enter.

The Endeca IAS Service is registered and started.

You can confirm that IAS is running by starting a Web browser and loading the IAS Server WSDL.
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If you installed IAS into Jetty Web Server, open http://<hostname>:8401/ias/?wsdl, or if you installed
into WebLogic Server, open http://<hostname>:8401/ias-server/ias/?wsdl.

The following WSDL displays:

<?xml version="1.0" encoding="UTF-8" ?>
- <wsdl:definitions name="IasCrawlerService" targetNamespace="http://endeca.com/eidi/ias
/2011-12" xmlns:ns1="http://schemas.xmlsoap.org/soap/http" xmlns:soap="http://schemas.xmlsoap.org
/wsdl/soap/" xmlns:tns="http://endeca.com/eidi/ias/2011-12" xmlns:wsdl="http://schemas.xmlsoap.org
/wsdl/" xmlns:xsd="http://www.w3.org/2001/XMLSchema">

- <wsdl:types>
...

Acquisition System Installation Guide

Installing IAS silently on Windows

IAS provides a silent installation mode that is useful if you want to add the IAS installation to a general Endeca
installation script, or install IAS on multiple machines using a scripted approach.

The silent installer is not interactive. You run the installation script and provide a text file as input. The text file
contains response values to the installation prompts that would normally be answered by a user.

The file must contain a single row that specifies a response value for each IAS installation prompt. The
response values vary depending on whether you are installing IAS into WebLogic Server or Jetty.

The order of prompts to install IAS into WebLogic Server is the following:

Installation mode
Weblogic home
IAS domain name
IAS domain user
IAS domain password
IAS domain port
IAS host

For example, here are the contents of a text file with response values that correspond to the WebLogic Server
prompts:

1
C:\Oracle\Middleware\wlserver
ias
weblogic
weblogic123
8401
mymachinename.companydomain.com

The order of prompts to install IAS into Jetty is the following:

Installation mode
Endeca IAS Service username
Endeca IAS Service user password
IAS port
IAS shutdown port
IAS host name

For example, here are the contents of a text file with response values that correspond to the Jetty prompts:

2
TEST\endeca
Password01
8401
8403
mymachinename.companydomain.com

Oracle® Endeca Information Discovery Integrator: Integrator Version 3.2.0 • January 2016



Installing the Integrator Acquisition System 24

To Install IAS silently on Windows machines:

1. Start a text editor and create a .txt file with response values as described above.

2. Save the .txt file to <install path>\IAS\<version>\bin.

For example, save the file as silent.txt.

3. Open a command prompt and change to the location of the installation script at <install
path>\IAS\<version>\bin.

4. Run the ias-setup.bat with the --silent flag, any optional arguments, and also specify the
response file as an input.

For example:

ias-setup.bat --silent < silent.txt

Acquisition System Installation Guide

Following installation, the WebLogic domain for IAS is restarted, and on Jetty, the Endeca IAS Service starts
automatically.

Installing on UNIX
This section describes how to install the Integrator Acquisition System on UNIX.

Installing IAS on UNIX

Adding the Endeca IAS Service to inittab on UNIX

Installing IAS silently on UNIX

Installing IAS on UNIX

The IAS software is distributed as a ZIP file that contains an installation script for UNIX platforms. You extract
the ZIP file and run the script to install IAS. IAS can be installed to any location, but this procedure assumes
IAS will be installed into /usr/local. IAS unpacks to approximately 400 MB. Because multiple versions may
be installed, a destination in a large partition is recommended. Differences between WebLogic Server and
Jetty installations are called out in each step.

To install IAS on UNIX:

1. Locate the installation file that you downloaded from the Oracle Software Delivery Cloud.

2. Extract the ZIP file to a temporary directory.

The ZIP file contains an installation script named EID_<version>_IAS.sh.

3. Open a command prompt, change to the temporary directory, and run the installation script with the
following command:

./EID_320_IAS.sh --target /usr/local

The script prompts you for a number of configuration options.

4. Select a server type to host the IAS installation:
• Type 1 to install IAS into WebLogic Server and press Enter.

• Type 2 to install IAS into Jetty Web server and servlet container and press Enter.
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5. If you selected 1 for WebLogic Server:

(a) Specify the WebLogic home location.

For example, this is typically /usr/local/Oracle/Middleware/wlserver.

(b) Specify a WebLogic domain name for IAS. Oracle recommends specifying ias.

(c) Specify a username for the domain name.

(d) Specify a password for the domain name.

(e) Specify a port for the WebLogic domain, or accept the default of 8401 by pressing Enter.

(f) Specify the fully qualified hostname that runs IAS, or accept the default by pressing Enter.

The IAS installation script creates the WebLogic domain with the username and password you
specified, deploys IAS as an application into the domain, and then restarts the domain.

6. If you selected 2 for Jetty:

(a) Specify a port for the Endeca IAS Service, or accept the default of 8401 by pressing Enter

(b) Specify a shutdown port for the Endeca IAS Service, or accept the default of 8403 by pressing
Enter.

(c) Specify the fully qualified hostname that runs IAS, or accept the default by pressing Enter.

To start the Endeca IAS Service after installation, navigate to
/usr/local/Oracle/Endeca/IAS/<version>/bin and run ias-service.sh.

You can confirm that IAS is running by starting a Web browser and loading the IAS Server WSDL.

If you installed IAS into Jetty Web Server, open http://<hostname>:8401/ias/?wsdl, or if you installed
into WebLogic Server, open http://<hostname>:8401/ias-server/ias/?wsdl.

The following WSDL displays:

<?xml version="1.0" encoding="UTF-8" ?>
- <wsdl:definitions name="IasCrawlerService" targetNamespace="http://endeca.com/eidi/ias
/2011-12" xmlns:ns1="http://schemas.xmlsoap.org/soap/http" xmlns:soap="http://schemas.xmlsoap.org
/wsdl/soap/" xmlns:tns="http://endeca.com/eidi/ias/2011-12" xmlns:wsdl="http://schemas.xmlsoap.org
/wsdl/" xmlns:xsd="http://www.w3.org/2001/XMLSchema">
- <wsdl:types>
...
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Adding the Endeca IAS Service to inittab on UNIX

This topic applies only to IAS installations on Jetty Web server. You can skip this topic if you install IAS on
WebLogic Server. In a UNIX development environment, the Endeca IAS Service can be started from the
command line. In a UNIX production environment, however, Oracle recommends starting it from inittab.

In UNIX you run the IAS Server using ias-service.sh, located in
usr/local/Oracle/Endeca/IAS/<version>/bin. You can write a script that calls ias-service.sh
and is referenced in inittab.

When writing your script, Oracle recommends that you run the Endeca IAS Service as a user other than root.

This sample script (named start_ias_service.sh) sets the ENDECA_USER variable to the “endeca” user
and then issues an su command to change to the “endeca” user:

#!/bin/sh
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ENDECA_USER=endeca
IAS_ROOT=/usr/local/Oracle/Endeca/IAS/3.2.0
IAS_WORKSPACE=/usr/local/Oracle/Endeca/IAS/workspace

# change to user endeca
su $ENDECA_USER -c "cd $IAS_ROOT/bin; \

$IAS_ROOT/bin/ias-service.sh >> $IAS_WORKSPACE/logs/ias-service-wrapper.log 2>&1"
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The start_ias_service.sh script is then referenced in inittab with an entry similar to this example:

eias:2345:respawn:/usr/local/Oracle/Endeca/IAS/3.2.0/bin/start_ias_service.sh

When writing your startup script, keep in mind that it is server-specific, and therefore its details (such as paths
and user names) depend on the configuration of your server.

Installing IAS silently on UNIX

IAS provides a silent installation mode that is useful if you want to add the IAS installation to a general Endeca
installation script, or install IAS on multiple machines using a scripted approach.

The silent installer is not interactive. You run the installation script and provide a text file as input. The text file
contains response values to the installation prompts that would normally be answered by a user.

The file must contain a single row that specifies a response value for each IAS installation prompt. The
response values vary depending on whether you are installing IAS into WebLogic Server or Jetty.

The order of prompts to install IAS into WebLogic Server is the following:

Installation mode
Weblogic home
IAS domain name
IAS domain user
IAS domain password
IAS domain port
IAS host

For example, here are the contents of a text file with response values that correspond to the WebLogic Server
prompts:

1
/usr/local/Oracle/Middleware/wlserver
ias
weblogic
weblogic123
8401
mymachinename.companydomain.com

The order of prompts to install IAS into Jetty is the following:

Installation mode
IAS port
IAS shutdown port
IAS host name

For example, here are the contents of a text file with response values that correspond to the Jetty prompts:

2
8401
8403
mymachinename.companydomain.com

To install IAS silently on UNIX machines:

1. Start a text editor and create a .txt file with response values as described above.
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2. Save the .txt file to <install path>/IAS/<version>/bin.

For example, save the file as silent.txt.

3. Open a command prompt and change to the location of the installation script at <install
path>/IAS/<version>/bin.

4. Run the install script with the --silent flag, the --target flag (which specifies the absolute path of
the target installation directory), any optional arguments, and the response file as an input.

For example:

./EID_3.2.0_IAS.sh --silent --target /usr/local < silent.txt
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After installation, the WebLogic domain for IAS is restarted automatically. In Jetty installations, you start IAS
by changing to /usr/local/Oracle/Endeca/IAS/<version>/bin and running ias-service.sh.

Web Crawler installation
The Endeca Web Crawler is installed as part of IAS.

The Web Crawler startup script is in IAS\<version>\bin (and in the equivalent path on UNIX). The Web
Crawler configuration files are in IAS\workspace\conf\web-crawler (and in the equivalent path on
UNIX). See the Integrator Acquisition System Web Crawler Guide for details and usage.

Package contents and directory structure
The IAS directory is the root directory for the Integrator Acquisition System.

After installing the Integrator Acquisition System, you see this directory structure:

IAS
3.2.0

bin
...

workspace
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The contents of the IAS directory are described here in detail.

Directory Contents

<version>\bin
• Scripts to start the IAS Service on Jetty (ias-
service.sh and ias-service.bat).

• Scripts to shut down the IAS Service on Jetty (ias-
service-shutdown.sh and ias-service-
shutdown.bat).

• Scripts to run the IAS Server Command-line Utility
(ias-cmd.sh and ias-cmd.bat).

• Scripts to run the Component Instance Manager
Command-line Utility (component-manager-cmd.sh
and component-manager-cmd.bat).

• Scripts to run the Record Store Command-line Utility
(recordstore-cmd.sh and recordstore-
cmd.bat).

• Scripts to run the Web Crawler (web-crawler.sh for
and web-crawler.bat).

• Executable to run the IAS Service as a Windows
service on Jetty (ias-service-wrapper.exe).

<version>\doc The reference documentation (Javadoc) for the IAS Server,
the Component Instance Manager, the Record Store, the
IAS Extension API, and the Web Crawler.

<version>\doc\wsdl The Web Service (WSDL) files for the IAS Server, the
Component Instance Manager, and the Record Store.

<version>\java The JDK used to run the IAS components.

<version>\lib
• Libraries for the IAS command-line utilities including:

the IAS Server utility, the Component Instance Manager
utility, the Record Store utility.

• Libraries for the IAS APIs including: the IAS Server API,
the Component Instance Manager API, the Record
Store API, and the IAS Extension API.

<version>\lib\ias-server-plugins Libraries for IAS plugins and custom extensions (if
applicable).

<version>\lib\oit-sx The IAS Document Conversion Module libraries.

<version>\lib\web-crawler The Web Crawler libraries.
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Directory Contents

<version>\sample Directories for the sample applications and sample
extensions. The sample applications are documented in the
IAS Developer's Guide and also in the IAS Extension API
Guide.

<version>\webapps\jetty The root.war file, which is the IAS Server and
Component Instance Manager as a standalone application.

<version>\webapps\weblogic
• The ias.war file, which is the IAS Server and

Component Instance Manager as a WebLogic
application.

• The Plan.xml file, which is the WebLogic deployment
plan for security configuration.

<version>\workspace_template The template for the workspace directory that contains
configuration files.

workspace The working directory for the IAS Server and the Web
Crawler.

workspace\conf
• The commandline.properties file, which contains

the IAS Service settings necessary for the IAS
command-line utilities to run.

• Three logging configuration files (ias-
service.log4j.properties
for the IAS Service, recordstore-
cmd.log4j.properties for the Record Store, and
ias-cmd.log4j.properties for the Command-line
Utility).

• The Jetty configuration files.

workspace\conf\web-crawler\default The default configuration files for the Web Crawler,
including the log4j.properties logging configuration
file.

workspace\conf\web-crawler\non- Sample crawl configuration files for non-polite crawls. As
polite-crawl with the polite version, the settings in these files will

override the default settings.

workspace\conf\web-crawler\polite- Sample crawl configuration files for polite crawls. The
crawl settings in site.xml will override the same property

settings in the default.xml file, while the crawl-
urlfilter.txt file will also override the default version
of the file.

Oracle® Endeca Information Discovery Integrator: Integrator Version 3.2.0 • January 2016
Acquisition System Installation Guide



Installing the Integrator Acquisition System 30

Directory Contents

workspace\logs The ias-service.log file, which contains the IAS
Service log output, and includes log messages from all
crawls managed by the IAS Server.

workspace\output Default destination directory for the crawl output from the
Web Crawler. The output directory is not present upon
installation. It is created when the Web Crawler writes to
output records for a crawl.

workspace\state State files for the IAS Service components. State files can
include Record Store instances, state directories for data
source extension information, and state directories for
manipulator extension information.

Note: There is no logs directory for the Web Crawler, because by default the Web Crawler sends its
standard output to the console. However, you can modify the log4j.properties file to send the
output to a file.
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Chapter 3

Uninstalling the Integrator Acquisition
System

This section describes how to uninstall the Integrator Acquisition System.

Uninstalling IAS on Windows

Uninstalling IAS on UNIX

Uninstalling IAS on Windows
To uninstall on Windows, you first back up the workspace directory, then follow the appropriate uninstall
process.

Before uninstalling, ensure that you have met the following prerequisites:

• If you are uninstalling on Jetty, ensure you have administrator privileges on the local machine.

To uninstall IAS from a Windows machine:

1. From Windows Explorer, copy the <install path>\IAS\workspace directory to a backup location
that is outside the IAS installation directory.

(You might use this content later in migration scenarios.)

2. For IAS installations on Jetty Web server:

(a) From Windows Services console, stop the Endeca IAS Service.

(b) Open a command prompt window and change to <install path>\IAS\<version>\bin.

(c) Run uninstall-ias-service.bat to remove the Endeca IAS Service.

If you leave the Windows Services console open after removing the Endeca IAS Service, it does not
update to show that the service has been removed until you close and re-open it.

3. For IAS installations on WebLogic Server:

(a) Stop the IAS application from either the Weblogic Administration Console or by navigating to
<IAS domain path>\bin and running stopWeblogic

(b) Remove the WebLogic domain for the IAS application. For details, see the WebLogic
documentation.

4. From Windows Explorer, navigate to the Endeca installation directory and delete the IAS directory.

For example, this is typically located at C:\Oracle\Endeca.
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Uninstalling IAS on UNIX
The Integrator Acquisition System must be manually uninstalled.

To uninstall IAS from a UNIX machine:

1. Stop IAS.
• For IAS installations on Jetty Web server: open a command prompt, navigate to <install

path>/IAS/<version>/bin, and run ias-service-shutdown.sh.

• For IAS installations on WebLogic Server: stop the WebLogic Server using either the Weblogic
Administration Console or by navigating to <domain path>/bin and running
stopWeblogic.sh.

2. Copy the <install path>/IAS/workspace directory to a backup location that is outside the IAS
installation directory.

(You might use this content later in migration scenarios.)

3. In a command prompt, issue an rm command as in this example:

rm -rf Oracle/Endeca/IAS

4. For IAS installations on WebLogic Server, remove the WebLogic domain for the IAS application. For
details, see the WebLogic documentation.
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